Circuite si Dispozitive pentru Microunde

Lucrareanr. 1

Noti: Chiar daca o imagine contine mai multa informatie decat textul din 1000 de cuvinte, trebuie citit si
textul.

Proiectarea unei retele de adaptare de impedanta

Dezadaptarea, cu pierderea corespunzatoare de putere, apare Tn momentul in care existd o nepotrivire
intre impedanta generatorului de semnal si impedanta sarcinii. Aceasta poate fi controlatd in mai multe
moduri, varianta cea mai simpla fiind cea amintita pe scurt la curs, utilizarea unei linii de lungime A/4 la
frecventa de lucru, cu o impedanta caracteristica situatd la egala departare (progresie geometrica) ntre

valoarea impedantei generatorului si sarcinii. In locul unei modificari in salt a impedantei se obtine o trecere
(scadere sau crestere) graduala a impedantei, imbunatatindu-se transferul de putere la frecventa de lucru.

Dezavantajul transformatorului in sfert de lungime de unda consta in banda relativ ingustd. Obtinerea
unei benzi de adaptare mai larga se poate obtine prin introducerea intre generator si sarcina a mai multor
sectiuni de linie de lungime A/4 la frecventa de lucru, scopul fiind acelasi, obtinerea unei scaderi sau cresteri
graduale a impedantei. Ca urmare valorile impedantelor caracteristice trebuie si fie crescitoare sau
descrescatoare (eventual strict).
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Primul pas va consta in proiectarea acestei retele in functie de datele individuale primite. Pentru
relatiile de calcul sunteti rugati sa cititi cursurile 3 si 4 (2015/2016). La laborator se vor folosi tabelele
pentru proiectare rapidd, pentru transformatorul cu mai multe sectiuni binomial sau Cebisev. Cele doua

modalitati de alegere a impedantelor diferd prin modul in care este permisa atingerea limitei de pierdere de
putere (doar la capetele benzii - binomial, sau de mai multe ori in interiorul benzii - Cebisev)

Vom presupune ca tema primitd constd in proiectarea unui transformator binomial cu trei sectiuni
care sa adapteze o sarcina de 110Q2 la un generator de 50Q la frecventa de 3 GHz. Aceasta va implica un
raport Z,/Zy = 2. Deci din tabelul corespunzator vom retine linia pentru Z,/Zy = 2 din zona corespunzatoare
transformatorului cu 3 sectiuni (N=3).

Z1/1Z, = 1.0907, Z;=54.53 Q; ZylZy=1.4142, 7,=70.71 Q; Z3/Zy = 1.8337, Z5=91.68 Q

Se mentioneaza in acest moment ca, desi tabelele sunt completate numai pentru valori Z,/Z, > 1, ele
pot fi folosite si pentru adaptarea unui generator la o sarcind de impedanta mai mica. Astfel pentru adaptarea
(aproximativa in acest moment) de la 50Q la 110Q se intercaleaza impedantele caracteristice calculate
pentru obtinerea unei succesiuni (crescatoare) 50Q, 54.53Q, 70.71Q, 91.68Q, 110Q. Aceleasi impedante
dar in ordine inversa, vor realiza succesiunea descrescatoare pentru adaptarea unui generator de 110Q la o
sarcina de 50Q: 110Q, 91.68Q, 70.71Q, 54.53Q2, 50€).




Ca urmare, pentru utilizarea tabelelor urmatoare se va interpreta ca Zy valoarea cea mai mica dintre
cele doua impedante primite in tema (generator sau sarcind), iar ca Z, valoarea cea mai mare.

Transformator binomial cu mai multe sectiuni

N=2 N=3 7 N=4

Z./Zy Z/Zo Z,/Zy Z,/Z Z/Zy Z5/Zy Z,/Zy Z5/Zy Z>/Zy Z4/Zo

1.0 1.0000 1.0000 1.0000 1.0000 1.0000 1.0000 1.0000 1.0000 1.0000
1.5 1.1067 1.3554 1.0520 1.2247 1.4259 1.0257 1.1351 1.3215 1.4624

- -~

2.0 11892 16818 | 10907 14142  1.833>| 1.0444 12421 16102 19150
3.0 13161 22795 | 11479 " 173317 26135 | 10718 14105  2.1269  2.7990
4.0 14142 28285 | 1.1907 20000 33594 | 1.0919  1.5442 25903  3.6633
6.0 15651 38336 | 12544 24495 47832 | 1.1215 17553 34182  5.3500
8.0 16818 47568 | 13022 28284 61434 | 1.1436 19232  4.1597  6.9955

10.0 1.7783 5.6233 1.3409 3.1623 7.4577 1.1613 2.0651 4.8424 8.6110

Zi]Zy | Z)]Zy Za]Zo  Z3]Zy  ZslZy Zs/Zo | ZiJ/2o  Z2f/Zy  Za]Zy  ZsfZo  Zs/Zy  Ze/Zy

1.0 1.0000  1.0000  1.0000 1.0000 1.0000 | 1.0000 1.0000 1.0000 1.0000 1.0000 1.0000
1.5 1.0128  1.0790  1.2247 13902 14810 | 1.0064 10454 1.1496 13048 14349  1.4905
2.0 1.0220 1.1391 14142 17558 19569 | 1.0110 1.0790 12693 15757 1.8536 1.9782
3.0 1.0354  1.2300 17321 24390 2.8974 | 1.0176  1.1288 14599 2.0549 26577 2.9481
4.0 1.0452 12995 2.0000 3.0781 3.8270 | 1.0225 1.1661 1.6129 24800 34302 39120
6.0 1.0596 14055 24495 42689 56625 | 1.0296 1.2219 1.8573 32305 49104 58275
8.0 1.0703  1.4870 2.8284 53800 74745 | 1.0349 1.2640 2.0539 3.8950 6.3291 7.7302
10.0 1.0789  1.5541 3.1623 6.4346 92687 | 1.0392 12982 22215 45015 77030  9.6228

Transformator Cebasev cu mai multe sectiuni

N=2 N=3
Cr =0.05 . =020 Fw =005 I'm =020

Zil2y | Z))Zy  Z2/2¢ | Zi]/20  Za]Zo | Zi]Z0 Z3/Z¢  Z3]2o | Z)/20 Z2]Zo  Z3/Z

1.0 1.0000  1.0000 | 1.0000 1.0000 | 1.0000 1.0000 1.0000 | 1.0000 1.0000 1.0000
1.5 1.1347  1.3219 | 1.2247 12247 | 1.1029 1.2247 13601 | 1.2247 1.2247 1.2247
2.0 12193 1.6402 | 1.3161 1.5197 | 1.1475 14142 17429 | 1.2855 14142 1.5558
3.0 1.3494 22232 | 14565 20598 | 1.2171 1.7321 24649 | 13743 1.7321 2.1829
4.0 14500 27585 | 1.5651 2.5558 | 1.2662 2.0000 3.1591 | 14333 2.0000 2.7908
6.0 1.6047 37389 | 1.7321 3.4641 | 1.3383 24495 44833 | 1.5193 24495 39492
8.0 1.7244  4.6393 | 1.8612 4.2983 | 1.3944 2.8284 57372 | 1.5766 2.8284 5.0742
10.0 1.8233 54845 | 1.9680 50813 | 14385 3.1623 6.9517 | 1.6415 3.1623  6.0920

N =4

I = 005 [ =020
2i]Zy | Zi]Zy  Z3/Z0  Zs3]Zy  ZslZy | Z)]Zo Za/Zy  Z3fZy  Z4]Zy

1.0 1.0000  1.0000 1.0000  1.0000 | 1.0000 1.0000 1.0000  1.0000
1.5 1.0892  1.1742  1.2775 13772 | 12247 1.2247 1.2247  1.2247
20 1.1201  1.2979 1.5409 1.7855 | 1.2727 13634 14669 15715
3.0 1.1586 14876 2.0167 25893 | 1.4879 1.5819 1.8965 2.0163
4.0 1.1906  1.6414 24369 3.3597 | 1.3692 1.7490 22870 29214
6.0 1.2290  1.8773  3.1961 48820 | 1.4415 2.0231 29657 4.1623
8.0 1.2583  2.0657 3.8728 6.3578 | 14914 22428 3.5670 5.3641
10.0 1.2832 22268 44907 7.7930 | 1.5163 24210 4.1305 6.5950




Pornirea programului ADS

Programul de simulare utilizat Tn laborator este Advanced Design System produs de firma Agilent
Technologies (companie separata din Hewlett Packard). Programul este instalat pe sistemul de operare XP
Professional. In laborator gisiti acest sistem pe o masina virtuala. Detectati pe desktop icoana care porneste
VMware Player. Tn interfata programului identificati masina virtuala "RF XP Professional" sau alegeti
comanda "Open a Virtual Machine" si cautati masina in directorul (tipic) D\DCMR\WXP_CIM.

Programul se porneste utilizand butonul de Start din Windows alegand succesiunea de comenzi Start
> All Programs > Advanced Design System 2003A > Advanced Design System.
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Fereastra principala a programului - Advanced Design System (Main) permite gestionarea
proiectelor (creare, stergere, arhivare — in scopul transportului unui proiect pe un alt calculator exista
implementatd o metoda de arhivare format zip, rezultand un fisier cu extensia “zap” care va pastra structura
interna de directoare a proiectului), accesul la fisierele individuale ale proiectului. Fiecare proiect va fi stocat
intr-un director propriu cu numele ‘“nume ales” + “ prj”, implicit in directorul de instalare
“C:\ADS2003A\users\default\” dar calea poate fi modificata (si cea implicita, de instalare, si individual la
crearea unui proiect nou).
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Pentru a asigura gasirea mai usoara a fisierelor este recomandat sa alegeti comanda View > Startup
Directory pentru a ajunge in directorul implicit urmata de comanda File > New Project pentru a crea un
proiect nou. Aceleasi comenzi pot fi aplicate utilizind butoanele din bara de comenzi a programului. In
fereastra care apare se introduce numele dorit al proiectului dupd calea deja afisata
“C:\ADS2003A\users\default\” fara terminatia “ prj” care va fi adaugata automat de program. Numele
proiectului va fi dat de numele unuia din componentii echipei de la statia de lucru, urmat de indicativul
grupei. Exemplu: C:\ADS2003A\users\default\popescu5401
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Se creeaza astfel proiectul respectiv, care este deschis automat. Implicit se creeaza si 0 prima
schemd, intr-o fereastra noui care poate fi utilizati pentru a desena schema ce urmeaza a fi simulata. In caz

ca aceastd fereastrd nu a fost creatd se poate alege butonul |I pentru a genera aceastd schema sau

comenzile File > New Design din meniu. Este recomandat sid se salveze aceasta schema (fereastra
[popescu5401 prj] untitledl) | [ﬂ pentru a avea un nume ce poate fi recunoscut. Dupa salvare fisierul

corespunzator va putea fi gasit in sectiunea networks din structura proiectului (fereastra principala - Main)
in caz ca il veti inchide din greseala.
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Select: Enter the starting point 0 items 3.000, 2,000 in  AJRF  SimScher

Simularea transformatorului de impedanta

In schema existentd de la pasul precedent vom desena transformatorul multisectiune calculat pentru
datele proprii. Pentru aceasta se acceseaza paleta de componente unde apare impartirea pe sectiuni a
elementelor care pot fi introduse. Implicit paleta deschisa este Lumped-Components dar va trebui sa
schimbati pentru a introduce elemente linie de transmisie TLines-ldeal. Elementul care trebuie introdus este
primul din lista intitulat TLIN. Reprezintd linia de transmisie ideald, in care elementele referitoare la

structura sunt eliminate.
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Introduceti in schema 3 sectiuni de linii de transmisie. Veti remarca ca implicit impedanta
caracteristica este de 50 Ohm, lungimea electrica (E = Bl) este de 90 grade la frecventa de 1GHz.



i [ popescu5401_prj ] untitled1 * (Schematic): 2

File Edit Select View Insert Options Tools Layout Simulate Window Dynamiclink DesignGuide Help
= P g 5 4 | 2 = 5 = o | A | 2o
Dl E|@| | e @] o]0 @) R R E 8 L ]| mi
ines- % = = m &=
TLines-deal ~| [run BRI 1 RN A R L =
o | =
LN | TLING
-
L= Lol
GLIN | TLOC
al | =
LSC | TLINP R o T e Sk Ryl o o
e = [ .. . . o o TN o o TUN L THN
e | TL1 TL2 TL3
ool B [ S A )1 R e S S 1 1
poc | TLpsc R e N = (5 2 S e e e E = (S HZ R S A e F = (G 2
O | A
COAK | Coarlee
2|
OR RCLIN
Select: Enter the starting point 0 items wire 3.625, -1.750 £1.125, -2.125 in  ARF  SimScher /

Va trebui sd schimbati aceste valori. Prin dublu click pe un element se deschide fereastra
corespunzatoare elementului in care se pot schimba acesti parametri.
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Simularea care va releva calitatea adaptarii va fi o simulare a parametrilor S. Pentru a indica
simularea pentru schema, trebuie introdus un controler de simulare, in acest caz el poate fi gasit in paleta
Simulation-S_Param Se introduc elementele din imagine: un controler de simulare si doi terminatori care
vor fi cele doua porturi: intrarea si iesirea. In acest caz ne intereseaza ca terminatorul de intrare sa aiba o
impedanta de 50 Q iar cel de iesire de 110 Q. De asemenea simularea trebuie facutd intr-o banda in jurul
frecventei de 3 GHz, de exemplu in banda 1-3 GHz cu un pas de 0.05 GHz. Nu uitati sa schimbati
parametrii controler-ului de simulare corespunzator temei primite. De asemenea impedantele
terminatorilor trebuie schimbate, pentru a corespunde valorilor din tema individuala.
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Utilizati fire |\_| masa | = | si eventual rotire 'L,:l din bara de comenzi pentru a completa

schema.
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Urmeaza simularea efectiva {%l sau F7 sau comanda din meniu Simulate > Simulate. Deoarece

este 0 simulare de circuit, cu modele corespunzatoare dispozitivelor, va puteti astepta ca simularea sa dureze
putin, de ordinul secundelor. Fereastra simulatorului prezentata mai jos raimane deschisa. Urmariti mesajele
pentru a identifica un eventual mesaj de eroare. Daca e cazul, incercati sa il interpretati si sd corectati
eroarea, in caz de insucces apelati la ajutorul cadrului didactic.



Status ~ Summary

Simulation finished: data=set "1pf' written in:
Coaaserssdefaultlabl_pritdatal .

Reszource usage:
Total stopwatch time: 4.23 seconds.
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Dupa terminarea cu succes a analizei se va deschide fereastra de vizualizare a rezultatelor. Rezultatul
care va prezenta succesul adaptarii la frecventa data fi reprezentarea parametrilor S din care sa rezulte un
coeficient de reflexie nul la acea frecventa. Deoarece raportul Z,/Zy nu a fost identificat cu precizie in tabel,
va puteti astepta sa nu obtineti de la inceput valoarea minima a lui Sy; la frecventa data.
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Va intereseaza sa reprezentati coeficientul de reflexie ca amplitudine, deci veti alege in momentul
plasarii graficului rectangular pe ecran S(1,1) si reprezentarea modulului (Magnitude).
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Adaptarea nu este perfecta datorita raportului Z/Z, care nu este exact egal cu 2. Va fi necesara
utilizarea utilitarului de reglaj fin pentru a finaliza adaptarea . Pentru aceasta selectati elementele pe care

doriti sa le modificati (TL1, TL2 si TL3 in acest caz) si apasati |Llrﬂgﬂ”; pentru a porni utilitarul de reglaj.
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Va fi necesar poate sd modificati (dupa preferintd) alegerea din zona Simulate si Trace History
pentru a urmari rezultatul cu claritate In timp real. Se vor modifica impedantele caracteristice ale celor trei
linii de transmisie pentru a obtine rezultatul dorit. Utilizati 1-2 marker-i ( Marker > New ) pentru a
vizualiza rezultatele in vederea predarii lor.

Rezultatele finale ar trebui sa fie similare celor din figurile urmatoare.
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Pentru transformatorul binomial se va avea in vedere sa se obtind caracteristica care atinge valoarea

0 (sau foarte apropiatd) la frecventa de functionare, are o forma cu minim plat, si e caracterizatd de cea mai
larga banda posibil (cu respectarea celorlalte conditii).
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Pentru transformatorul Cebisev se va avea in vedere s se obtind o caracteristica care atinge valoarea

0 (sau foarte apropiatd) in trei puncte (numarul de sectiuni de linie) din care unul la frecventa de
functionare, iar maximele dintre acestea ating valoarea coeficientului de reflexie maxim admisibil (primit in
tema).

In ambele situatii, doi marker-i (sau 1 marker care este mutat) se folosesc pentru a detecta cele doua
frecvente care reprezinta capetele benzii de adaptare cu limita de coeficient de reflexie impusa prin tema.



